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Introduction 

This Concise User Guide is meant to assist new users of the Rumen8 ration formulation software and 

the SNV Tropical Feed Library in Tropical regions. At the outset it is emphasised that both tools are 

only aids to optimise dairy cow diets. Before calculations are started, the user of the tools should make 

thorough observations on the dairy farm of, among other things, the cows, the feed, the forages in the 

field, the water, the environment, the milking and handling of the animals, the level of management 

and the farm records, including the prices paid for the feedstuffs and received for the milk.  

This ‘farm walk’ is depicted in Figure 1. It is particularly important to get as accurate an idea as possible 

about the quantities and qualities of feedstuffs given and the milk produced. When farmers do not keep 

records, obtaining accurate data can be a challenge. Rumen8 is to be used in a conducive environment 

and is only a management ‘aid’ (hence the name Rumen8) when integrated in a broader farm coaching 

program.  

 

 
Figure 1. Cumulative steps in dairy farm coaching 

For use in tropical countries, it is recommended to use Rumen8 with the SNV Tropical Feed Library 

that contains 237 tropical forages, co-products, grains, legumes and other feedstuffs. It is important 

to use the region-specific feed library as tropical forages have higher levels of neutral detergent fibre 

(NDF) and lower levels of crude protein than many temperate feeds. Data for the Tropical Feed Library 

were obtained from about 10 trusted published sources. 

The library was developed for use in East Africa but has relevance for most lower latitude regions and 

new feeds can easily be added for individual use. The Australian feed library, which is provided with 

Rumen8, can be used as one of the sources for new feeds, but as is it is not adequate for countries 

with a tropical climate. An alternative resourceful website with feed tables of tropical forages is 

https://www.feedipedia.org/. Many of the feeds in the tropical library contain links to additional 

information of the Feedipedia website. 

It goes without saying that feed analyses will add a lot to the predictive power of any diet formulation 

tool. Instant feed analyses can be done at the farm using handheld NIRS, provided the predictions are 

based on equations that were validated with feed samples from relevant tropical regions. However, 

currently this is rarely a realistic option.  

https://www.feedipedia.org/
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Downloading Rumen8 and the SNV 

Tropical Feed Library 

Rumen8 requires the Microsoft Windows operating system to run. This can be Windows 7, 8.1, 10 or 

11 and computers need a minimum screen resolution of 1024 x 768. (See 

https://www.rumen8.com.au/mac/index.html for how to run Rumen8 on Apple Macintosh computers). 

The first step is to download the Rumen8 software and the SNV Tropical Feed Library. This can be done 

from  https://cowsoko.com/rumen8 or by following the steps below. It is important to note that the 

Tropical Feed Library can be read and used only with the Rumen8 diet formulation software. 

First install the Rumen8 software from https://www.rumen8.com.au/download/index.html.  

Once the installation is complete, in your Documents folder, go into the Rumen8 folder and create a 

new folder named <SNV Tropical Feed Library3.1>. 

We advise to download the Feed Libraries using Google Chrome as your browser. 

Download the latest version of the Tropical Feed Library (currently SNVFeedLibrary3.1.db3) from 

https://cowsoko.com/rumen8 and save it in the folder <SNV Tropical Feed Library3.1>. To use the feed 

library with Rumen8 version 3.7 and lower, it must be renamed from <SNVFeedLibrary3.1.db3> to 

<FeedLibrary.db3> in Windows File Explorer. Ignore this step if you are using Rumen8 version 4 or 

higher. 

The SNV Tropical Feed Library requires version 3.5.0.0 or higher of Rumen8. Before using the library, 

please ensure you are using the latest version of Rumen8 by checking for updates in the Help menu.  

To open the Tropical Feed Library, start the Rumen8 program which will open with the default Feed 

Library (usually the provided Australian Feed Library). Click ‘Edit’ in the left top corner menu of the 

Rumen8 window and then click on ‘Edit feeds’. The Feed Editor window will open. Click on the right-

most tab called ‘Manage libraries and Ingredient visibility’. 

Instructions for Rumen8 version 3.7 and lower 

In the bottom right half of the window click on ‘Open’ under <User feed library>. Move into the <SNV 

Tropical Feed Library3.1> folder you created earlier and the downloaded and renamed file 

<FeedLibrary.db3> is visible. Click on it and then click on the ‘Open’ button.  

In the top right section of the Feed Editor window, under ‘Diet ingredients available’ you will see a 

figure of 237 feeds from the Tropical Feed Library. The Feed library in use now shows a blue ‘User’ flag 

as a reminder you are no longer using the supplied default library. Placing the cursor on the blue 

rectangle shows the path to where the library is stored. Once downloaded, Rumen8 and libraries can 

be used offline. 

Instructions for Rumen8 version 4.0 and above 

On the right side of the windows click the ‘Import’ button in the ‘Library’ column. Note, not the second 

import button at the bottom of the window under the ‘Share’ section. Move into the <SNV Tropical 

Feed Library3.1> folder you created earlier and the downloaded file <SNVFeedLibrary3.1.db3> is 

visible. Click on it and then click on the ‘Open’ button. You will then be prompted to give the imported 

library a name so enter ‘SNV Tropical Feed Library 3.1’ in the entry box and click ‘Okay’. 

Once the library has been imported in the top right section of the Feed Editor window, under ‘Diet 

ingredients available’ you will see a figure of 237 feeds from the Tropical Feed Library. 

https://www.rumen8.com.au/mac/index.html
https://cowsoko.com/rumen8
https://www.rumen8.com.au/download/index.html
https://cowsoko.com/rumen8
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Your library can be edited according to your need for more feeds or the quality of feed available on the 

farm based on your observations or available feed analyses. We recommend you always create a copy 

of a feed before changing it, so the original feed definition remains. When creating a copy typically a 

suffix is appended to the original name that says what the feed is being used for. This might be a 

property name, batch number or just a date for example. 
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This Concise Guide is a complement 

to the Rumen8 User Guide 

When installing Rumen8, three supporting documents are placed in the Rumen8 group in the Start 

menu of your laptop. They User Guide is updated whenever Rumen8 is (243 pages in the 2022.09 

edition). It is used most frequently and can also be accessed through the Help menu, the help button 

(?) in the top right of most Rumen8 windows (not the main window) or by pressing F1. The Rumen8 

Training Manual (46 pages in the 2019.11 edition) provides an introduction to nutrition but refers to 

an older version of Rumen8. The Rumen8 Feed Companion (171 pages in the 2017.1 edition) provides 

a summary of typical nutritional values of approximately 160 feeds in the Australian Feed Library that 

is supplied with the Rumen8 software package.  

This Concise User Guide is a quick start guide for users of Rumen8 in the tropics. It focusses on 

differences in the use of Rumen8 in the tropics such as the Tropical Feed Library and NDF to estimate 

dry matter intake. Where adherence to the User Guide is crucial to the running of Rumen8, sometimes 

a sentence from it is copied in this guide. That way, this guide can also be used stand alone. For more 

detailed guidance, the Rumen8 User Guide should always be consulted. A series of 13 video tutorials 

that introduce Rumen8 to the Australian industry and cover the commonly used functions of the 

software is available through https://www.rumen8.com.au/help/index.html. 

 

Terms and Conditions 

The Rumen8 software and the SNV Tropical Feed Library are provided ‘as-is’, without any express or 

implied warranty. In no event will the owners of Rumen8 and/or SNV Netherlands Development 

Organisation be held responsible and/or liable – or will accept liability - for any damages arising from 

the use of this software and/or the Tropical Feed Library. 

While all reasonable efforts have been taken to ensure the accuracy of the Rumen8 application and 

the Tropical Feed Library, use of the information so provided is at the user’s own risk. To the fullest 

extent permitted by Australian, Dutch and international law the developers of Rumen8 and SNV 

Netherlands Development Organisation, disclaim all liability for any losses, costs, damages and the 

like sustained or incurred as a result of the use of - or reliance upon - the information provided, 

including liability stemming from reliance upon any part which may contain inadvertent errors, whether 

typographical or otherwise, or omissions of any kind. 

Registering Rumen8 

When Rumen8 is run for the first time it will start in trial mode. This allows you to use all the functions 

of the application, but you are restricted to diets with only four ingredients. To get full access to all the 

diet ingredients please register, which is free. We ask you to register so the owners have an estimate 

of the number of people using the application. To register send an email to register@rumen8.com.au 

specifying the first and last names you would like to register under and the country you are based in. 

(For more information see page 21 of the Rumen8 User Guide 2022.09). Once you receive your 

https://www.rumen8.com.au/help/index.html
mailto:register@rumen8.com.au?subject=Rumen8%20registration
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registration information enter your name and registration number under the Registration option under 

the Help menu and click the ‘Register’ button. Now your name will always appear at the top of the 

Rumen8 window and you can use 15 diet ingredients in each diet in Standard Mode and 10 in Compact 

Mode. 

 

Using Rumen8 in Compact mode 

When starting to use Rumen8, it is recommended to do so in Compact Mode which reduces the window 

down to the essentials. Compact mode is recommended for learning how to use Rumen8, and for many 

users in the tropics, will be enough to formulate diets.  

Switching between modes can be done in the File menu. Under Preferences in the File menu, also set 

the currency to the one you want to use. And one can set milk yield to be expressed in litres or 

kilograms with milk components expressed in mass/volume% or mass/mass%. The other settings 

under Preferences probably do not need to be changed and can be kept/set as shown in Figure 2. In 

this Concise Guide we use examples in KES (Kenyan Shillings). At the time of writing, in March 2022, 1 

KES roughly equalled €0.008, that is 1 € was approx. 125 KES. We checked ‘Do not display cents’ in 

order not to show cents in Rumen8. 

Thereafter, the cow is to be defined on the Dairy/Diet tab (Beef tab in beef mode), where also the diet 

can be entered as fed or in kg dry matter (DM) (Figure 3). For determining DM intake (DMI) capacity 

there are two options, either the conventional method (based on NRC 2001) or the so-called NDF 

method.  Rumen8 assumes a default value of NDF intake of 1.2% of body weight which can be altered 

in the Preferences (Figure 2).  For dairy cows in the tropics, NDF at about 1.3% of body weight may be 

a better estimator of DMI than the conventional method. However, DMI is a complex matter and, where 

possible, intake should be weighed and assumed intake should be replaced by observed intake. (In 

the ‘Diet detail’ tab of Standard mode, the percentage of maximum DMI in the ‘Conventional method’ 

is shown next to the ‘NDF method’. ‘Conventional (NRC)’ should never exceed 100%).  

One usually formulates for one cow that represents your herd or sub-herd. For milk yield, enter the 

average yield in the last 5-10 days of the herd or sub-herd. The example in Figure 3 is of a stall-fed 

cow and the distance walked is set at 0.5 km/d. Depending on the weight of the cow, walking on 

undulating terrain takes 2-3 MJ/km, which is equivalent to the energy required to produce 0.5 L of 

milk. Depending on farm size, a grazing cow will typically walk 4-5 km over a day in the paddock, in 

addition to the distance to and from the dairy for milking. 

The Cost/Price tab is where the Milk Price can be entered as well as costs or prices of the diet 

ingredients used. Also enter estimated costs of home-grown feeds, as otherwise Rumen8 will not 

calculate the diet cost. Feed losses can be altered here, which is especially relevant for silages, but 

can also be significant when feeding out supplements on the ground in the field. 

The example in Figure 3 is one of a diet deficient in metabolisable protein (MP) as shown by the red 

colour of the MP bar. This can be remedied by feeding more rapeseed (Canola) meal. At the same time, 

supply of a low protein ingredient such as mature Napier should be reduced because the cow is already 

at 100 % of her physical (i.e., NDF) intake potential. Note: A green bar indicates that supply meets 

demand (+/- 2%, provided ME, MP, DMI, and Minerals are set at +/- 2% in Preferences-Advanced) a 

red bar indicates that supply is below demand and a yellow bar indicates that supply exceeds demand. 
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Figure 2. Example of settings under Preferences in Compact Mode 

 

 

 
Figure 3. Example of a cow and diet in Compact mode 
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Figure 4. Example of settings of ingredient costs and milk price in Compact mode 

For the farmer, the most important parameter is the Margin Above Feed Cost (MAFC), which is milk 

income minus feed cost. It is shown in the bottom left summary section of Figures 3 and 4. 

6.1 Defining the animal 

The approach in Compact mode should be kept as simple as possible and the ‘Animal’ drop down menu 

on the left of the main window can be ignored till one feels comfortable with the program. Till then, the 

animal can be defined using your own judgement in the ‘Dairy/Diet’ section. A more generic approach 

is through the ‘Animal’ menu. There, based on the production level the diets are formulated for, one 

can chose generic Standard animals with 305-day lactation yields from 2,000 to 10,000 litres and 

allocate them to Early, Mid or Late lactation.  Table 1 shows an example of a 5,000 L cow. To access 

the Standard cow editor, one has to go into Standard mode, open Preferences, and select Standard 

cows. 

Table 1. Data of a Standard animal of 500 kg, producing 5,000 L in a 305-day lactation 
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The figures in Table 1 are the default values of an idealised cow with a calving interval of 365 days, 

which is not representative of many farms. You can use the standard animals to get started, but we 

recommend to always adjust the animal data to the actual situation on the farm the diet is calculated 

for. When a farmer has no data on milk composition, then milk fat % and milk protein % may be 

obtained from dairy companies or national statistics. Milk fat and protein strongly impact ME and MP 

requirements as shown in the tables that appear when putting the cursor on ‘Milk fat’ and ‘Milk protein’ 

on the ‘Dairy/Diet’ tab. 

6.2 Approach for grazing animals 

Formulating diets for grazing cows includes the additional challenge of estimating the quantity of 

grazed herbage. The best approach is to enter in the diet the quantities and qualities of all ingredients 

except grazed pasture. Examples are concentrates, silage, hay and cut and carried fodder.  

A walk through the pastures is required when estimating the quality of the herbage eaten, taking 

account of the quantity of feed on offer, and associated effect of selective grazing. We advise to 

approach the grassland quality with an average value of all the grasses and legumes in the pasture. 

Then enter in Rumen8 the feed from your library that best describes what is grazed, e.g., African foxtail 

grass, Couch grass, Kikuyu grass, Maasai love grass, Rhodes grass, Setaria grass, Star grass, Themeda 

grass, … Next, based on feed analyses (rarely available), or your judgement, edit the Table values of 

the grass that you entered, after first having made a copy of the feed and renamed it as ‘Pasture, Farm 

name, Date’. 

Subsequently, increase the quantity of grass in the diet to the level where ME supply matches ME 

requirements for the level of animal production set in the Dairy/Diet tab.  This should not exceed 100% 

of the ‘Conventional’ (NRC) feed intake limit. This ‘back calculating’ gives the best estimate of herbage 

intake. Now you can set out balancing the diet as described in this guide. 
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Using Rumen8 in Standard mode 

Figure 5 shows the same cow in Standard mode. The Standard mode shows many more variables, but 

it requires more experience and expertise to use and interpret. If you are unsure what the different 

terms in Rumen8 stand for, hover your mouse over the item and for most items a tool tip will appear 

providing a more detailed explanation. In Standard mode, the joint tabs for ‘Dairy/Diet’ and ‘Cost/Price’ 

are given separately and in more detail. New tabs include ‘Diet detail’ and ‘Compare’. Under the ‘Dairy’ 

tab, the inputs Live weight change, Days pregnant and Days in milk have calculators or calendars next 

to them to facilitate entering the right data. The calendars to estimate days in milk and days pregnant 

are self-explanatory. 

 

 
Figure 5. Screenshot of the cow of Figure 3 and Figure 4 in Standard mode; now on a balanced diet 
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7.1 Live weight change calculator 

The Live weight change calculator is a useful tool as shown 

in the following example. First hover over the caption ‘Live 

weight change (kg/d)’, and a Figure and Table with target 

Body Condition Scores (BCS) will appear. Note that those 

will only appear if a cow and diet are entered. Figure 6 on 

the left is a screenshot of the cow shown in Figure 3, i.e., 

weighing 550 kg, 125 days in milk and losing 0.11 kg per 

day.  

The Table (not shown here) that appears when hovering 

over ‘Live weight change (kg/d)’ shows a target Penn State 

BCS in mid lactation (d 101-200) of 3.0. If ‘our cow’ has a 

BCS of 2.5 then you may want to give the cow more feed 

to allow the BCS to rise by 0.5 units to 3.0. Then open the 

calculator and move the upper slide to 0.5 units and the 

lower slide to e.g., 75 days. (75 days was chosen to 

achieve the gain in BCS by 200 days in milk, which is the 

end of mid-lactation). 

 

 

 

 
The calculator shows that 0.32 kg/d live weight gain is needed to reach 0.5 units BCS at the end of the 

75-day period. Putting the cursor on the 0.32 kg/d shows that each day an additional 11.9 MJ ME and 

49 g MP are needed. That is roughly the equivalent of 2 L milk/d production! Click on <Okay> in the 

calculator and the live weight change of minus 0.11 kg/d increases by 0.32 kg/d to plus 0.21 kg/d. 

7.2 Diet detail and recommended levels 

The ‘Diet detail’ tab is a very valuable one in that it allows evaluation of a diet against Recommended 

levels of nutrients and other targets. This is indicated by the colour of the ‘traffic lights’ with green 

indicating that demand and supply match while a shortfall is indicated by a red traffic light and an 

oversupply is indicated by a yellow traffic light.  The recommended levels can be set by the 

experienced user under <File> <Preferences> <Recommended levels>. It has five level sets available. 

We recommend using the five physiological sets and settings as shown in Table 2. Those differ from 

the simplified example of Early Lactation (up to day 60 against day 100 in Table 1) shown on page 104 

of the Rumen8 User Guide version 2022.09. The transition or close-up period is the last 4 weeks before 

calving and is linked to days pregnant. Rumen8 assumes a gestation length of 285 days. 

These recommended nutrient levels are indicative only. They are based on theoretical considerations 

for cows of 500- 550 kg and producing 4,000- 5,000 L in a 305-day lactation period. The targets are 

to be treated with caution and use is at one’s own risk. Adjust the figures based on nutritional 

principles, level of production, feed quality (e.g., starch level and quality), feeding system (± TMR), 

manure consistency, level of management, etc. 

When ‘Recommended Levels’ are set, several smaller traffic lights will appear on the Diet and Diet 

detail tabs and these too show whether the current values are under (red), within (green) or above 

(yellow) the recommended ranges. Independent of the ‘Recommended Levels’, a warning may appear 

next to some parameters (e.g., starch) if the dietary level suggests the cow may be in danger of ruminal 

acidosis (Figure 7). For further information about each parameter displayed on the ‘Diet detail’ tab, 

hover your mouse over any heading and a tool tip will appear with an explanation. When hovering the 

mouse over any of the 6 progress bars on the ‘Diet’ tab, the actual values appear.  

Figure 6. Example of cow liveweight 

change calculator 
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Table 2. Target levels in different production phases of dairy cattle diets in the Tropics 

 

 

 

 
Figure 7. Examples of warnings on the Diet tab about the risk of ruminal acidosis 

 

7.3 Price 

In Standard mode in Rumen8 version 3.7 and below, 10 sets of 12 milk prices can be defined and given 

a name using the drop-down menu on the right side of the (Milk) Price tab. The ‘milk price sets’ can be 

renamed e.g., farm name, or for international consultants into country names. In the latter case, also 

change the currency under <Preferences> < General>. When working internationally it is advisable to 

maintain feed libraries per country with local prices that are updated each time a calculation is made 

in that specific currency/country. 

In Rumen8 version 4 and above different Price libraries can be used for different farms or countries. 

7.4 Feed cost 

Feed costs as well as feed losses can be viewed and altered on this tab. Please note that a Margin 

(MAFC) can only be calculated when all diet ingredients have a cost. Costs can be entered or altered 

on the Feed cost page and in all Feed libraries.  When changing a cost or losses (%) on the Feed cost 

page, the cost or losses will also change in the current feed library in use. 
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Costs and losses of the Diet ingredients used can also be viewed under ‘Diet ingredients’ on the left 

half of the main window. There, all diet ingredient details can be accessed in four ways. Putting the 

cursor on any of the 15 diet ingredient names opens a window in portrait orientation with all details of 

that ingredient. Alternatively, right-click on the number in front of the diet ingredient and a larger 

screen with all details will open in landscape orientation. The landscape orientation screen can also 

be opened by using the menu <View> <Ingredient detail> <Feed ingredient number>. 

7.5 View menu 

On the left side of the menu, Standard mode has a ‘View’ menu that provides interesting details on all 

diet ingredients as well as on the ME, MP and minerals calculations. For quick access from the main 

Rumen8 window to the ME, MP and Mineral calculations, just click <Ctrl> <E>, <Ctrl> <T> or <Ctrl> 

<M> on the keyboard or, on the ‘Diet’ and ‘Diet detail’ tab, left click on the headings ‘Metabolisable  

energy’, ‘Metabolisable protein’, ‘Calcium’, ‘Phosphorus’ or ‘Magnesium’. This section is particularly 

informative for students, especially when read together with the figures and text behind the tool tips 

on the ‘Diet detail’ tab. On that page, just hover over the captions ‘Metabolisable energy’, 

‘Metabolisable protein’, ‘Calcium’, ‘Phosphorus’ and ‘Magnesium’. 

7.6 Compare tab 

The Compare tab is a very useful feature. Here, 3 diets can be stored along with important parameters, 

including the quantities (as DM) of diet ingredients, percentage of optimal DMI (in the NDF method and 

NRC method), supply and demand of ME and MP and MAFC. This is a handy page to discuss with the 

farmer and to choose the best diet from (Figure 8). With the S(tore) button, the diet is saved in slot 1, 

2 or 3. They can be (R)estored or (C)leared. 

Sometimes, a tab ‘Split herd’ is shown to the right of the Compare tab. This facility is rarely used in the 

tropics, and we recommend to un-tick it under <File>, <Preferences>, <General> so it is no longer 

visible. 
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Using Rumen8 in Optimise 

(advanced) mode 

The Optimise function in Rumen8 is only recommended for those with a thorough knowledge of dairy 

cow nutrition and of computers. If you possess both, then the non-linear diet optimisation can assist 

you to formulate the lowest cost diet from up to 15 ingredients in a time efficient manner. Optimise 

requires Microsoft Excel to be installed along with its Solver add-in. To install Solver, follow all steps 

on pages 209-234 of the Rumen8 User Guide 2022.09. Now when you return to the main Rumen8 

window in Standard mode, a new tab called ‘Optimise’ will be available. 

The fewer constraints that are ticked in Optimise, the cheaper the diet, and the higher the MAFC. In a 

first approach you may only want to tick ‘ME demand’, ‘Intake (kg NDF)’ and ‘MP min. demand’ and 

click ‘Optimise’ to run the program. You will most likely get the message: ‘All constraints satisfied. 

Feasible diet found’. Thereafter open the ‘Diet detail’ tab and use your nutritional knowledge to see if 

and where things go wrong. For instance, you may see that the diet with the highest MAFC has 

unacceptably low NDF and forage contents, and/or too high a starch content. If that is the case 

warnings appear in the bottom right-hand corner of the Diet tab about a high risk of ruminal acidosis 

as shown in Figure 7. 

The next step is to set the next constraint, e.g., the range of Forage: Concentrate Ratio and run 

Optimise again. When formulating a diet for grazing cattle, first estimate pasture intake as described 

under section 6.2 and set this quantity as a fixed amount as one of the bottom four ingredient 

constraints. Set constraints step by step because setting unnecessary constraints will make the diet 

unnecessarily expensive. You may also get the warning: ‘Unable to formulate a diet within the specified 

constraints’. In that case you must lower the number of constraints or change the minimum or 

maximum values of the range within which a parameter must fall. Only do this when nutritionally 

justified. The constraint ranges on the Optimise tab can be quickly set to the recommended levels (set 

in ‘Preferences’) by clicking on the ‘RL’ button which opens the ‘Apply recommended levels to the 

optimiser’ window.  

 

Figure 8. Example of recommended levels for use with optimiser 



 

14 Dairy for nutrition, employment and sustainability 

Make sure the correct recommended levels set is checked. Up to 5 sets of recommended levels for a 

range of diet parameters can be set in the ‘Preferences’ providing quick feedback on the suitability of 

a diet on the Diet tabs. Depending on your experience, allow some deviations from the recommended 

levels because animal nutrition is not an exact science and sometimes relaxing the range by only a few 

percentage points can result in a much cheaper diet. When satisfied with the nutritional and financial 

optimum diet, store it under the Compare tab and save the file. 

 
Figure 9. Compare tab; diet 1 is unbalanced, diet 2 balanced manually and diet 3 using Optimise 

In the Compare section of Figure 9, diet 1 is the original diet shown in Figure 3 (Compact mode) that 

the farmer told us was being fed and achieving a milk production of 18 L. However, if the diet fed indeed 

is of the quantity and quality entered, then only 95% (1275/1339) of the MP demand was supplied, 

and milk yield is likely to drop to approximately 16.5 L. Diet 2 is well balanced and supports a milk 

yield of 18 L. Balancing was done as well as possible in Standard mode (Figure 5) and could also have 

been done in Compact mode. Diet 3 shows that MAFC can be increased by KES 21 (KES 257 minus 

KES 236) by using Optimise. With an identical ME and MP supply as Diet 2, Diet 3 was KES 21 per day 

cheaper, showing the strength of the Optimise facility. This does, of course, not hold if the diet 

ingredients are not weighed well or of a composition different from the ones in the feed library. 
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Other features of Rumen8 

This Concise User Guide cannot cover all the features of Rumen8. Some other possibilities worth using 

include making a farm feed library, editing feeds, making a feed mixture and creating a report, 

estimating emission of enteric methane, and diets for mated and unmated heifers. 

9.1 Farm Feed Library and editing feeds 

When advising at several farms, it is recommended to create user feed libraries for each farm, 

especially if there are differences in feeds, feed qualities and feed costs. Separate feed and price 

libraries are recommended when advising in different countries using local currencies.   

In Rumen8 version 3.7 and below, if the feeds are largely the same, but the currency differs, then it is 

much faster to save the first library under a new name and change the currency symbol and all costs. 

Costs of feeds, and often the milk price, almost always need to be changed at each farm visit. Editing 

costs can be done on the Feed cost page (see also section 7.4) and in the Feed Library.  

For Rumen8 version 4 and above a copy of the current feed or price library can be created and then 

modified to suit the farm or country in a similar way. 

Nutritive values can be edited in all feed libraries but it is highly recommended to make a copy of the 

feed you want to edit and save it under a new name. Thereafter, edit the values of the new feed that 

you have reason to change. Reasons for changing values include a feed analysis or a visual assessment. 

If the feed analysis has data for DM, ME, CP, NDF and starch, then only edit those values in the new 

feed. 

We recommend leaving all other values as copied. In the above example that includes fat, ash, peNDF, 

sugar, minerals, aN, bN and cN. Rumen8 will not calculate a diet if you leave blank one of the required 

feed parameters (bold names in the feed editor). Moreover, it will be difficult for most users to find 

reliable data on aN (proportion of water-soluble N, which is the immediately available portion of feed 

CP), bN (proportion of potentially degradable N, other than water soluble N) and cN (fractional rumen 

degradation rate/h of the b fraction). Outside the Rumen8 libraries, the nutritional tables in Feedipedia 

are one of the few places where aN, bN and cN values can be found, click the following link: 

(https://www.feedipedia.org/content/feeds ). 

Also note that the absorption coefficients for calcium, phosphorus and magnesium in the various 

libraries used in Rumen8 always are 0.30, 0.64 and 0.16 respectively for roughages and 0.60, 0.70 

and 0.16 for concentrates. 

Even when entering a totally new feed in your library, it is advisable to start with a copy of a similar 

feed of a similar category in the SNV Tropical feed library (SNVFeedLibrary3.1.db3) or the Australian 

Rumen8 feed library. By creating a new feed from an existing one you will automatically label them 

with the right ‘Feed management category’, Feed protein type’ and ‘Feed particle size classification’.  

9.2 Making a feed mixture 

Feed mixtures can be made in the Feed Library or created automatically from the current diet. To 

create mixes from feeds in the library, in the main window menu click <Edit> <Edit feeds> <Create 

mixes>. Click <Add New> if this is a new mixture. 

Multiple feeds can be added to the mix by selecting the first feed from the list of feeds, holding down 

the control key on the keyboard and then selecting the remaining feeds one at a time keeping the 

control key pressed. Then click on the arrow (<) button to move the selected feeds into the mix. Now 

enter the percentages of each feed, either on a ‘Dry matter’ or on an ‘As fed’ basis. 

https://www.feedipedia.org/content/feeds
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The feed percentages must equal 100% before you will be able to exit the mix editor and save the mix 

with a unique name. Before clicking ‘Okay’, enter a cost of the mix, which usually is the sum of the 

‘Ingredients cost’ shown plus a fee for mixing. Now the mix can be used in the diet. By putting the 

cursor on the name of the feed in the diet ingredient list, all parameters are shown. 

Mixtures can also be created automatically from the current diet by selecting <Edit> from the main 

menu and then <Create Mix from the Diet>.  Then unselect feeds that you don’t want included in the 

(compound) feed mix and provide the remaining information required to complete this action. Mix 

percentages can be shown on an as is or on a dry matter basis. This facility is also handy for Total Mixed 

Rations (TMRs). 

9.3 Making a report 

To create Rumen8 reports you must also install the SAP Crystal Reports Runtime Engine for the .NET 

framework. The installer for this software is available from the Downloads page of the Rumen8 website 

and there is more explanation on page 9 of the Rumen8 User Guide 2022.09. If you are unsure whether 

your version of Microsoft Windows is 32 or 64-Bit start Rumen8, load a few ingredients and then open 

the Report Designer from the File menu. 

Click on the ‘Create’ button and a warning will appear telling you the SAP runtime has not been 

installed. It will show you whether your version of Windows is 32 or 64-bit. Click on the links provided 

to download the correct runtime and then install it. Now the Report Preview window should appear 

when you create a report. 

The following report types can be generated: ‘Diet Report’, ‘Daily Feeding Sheet’, ‘Batching Sheet’, 

‘Diet Comparison Report’ and ‘Diet Comparison report (as fed)’. In addition, a Feed Composition Report 

can be generated by selecting <Edit> <Edits Feeds> (or Ctrl F) from the menu bar and then selecting 

the <Print> option. One can then select the feeds and/or mixes to be included in the feed composition 

report and select <Create> which will generate the report which can then be saved as a PDF or in 

alternative file formats. 

9.4 Estimating emission of enteric methane 

Rumen8 provides a prediction of enteric methane produced by the cow (equation 10 by Niu et al., 

2018). The equation is shown in the tooltip associated with the caption ‘Enteric methane’ on the ‘Diet 

detail’ tab. Methane is expressed both as total methane in grams per day and as the amount (in g) of 

methane produced per L or kg of milk. A higher milk yield dilutes the feed that is used for maintenance, 

and it follows that increasing milk yield is one of the most effective ways of lowering methane intensity. 

9.5 Diets for mated and unmated heifers 

Rumen 8 also has a handy calculator for heifers to estimate the required rate of gain to meet target 

live weight at mating or calving (55% and 94% herd mature weight respectively). An example is given 

in Figure 10. Once the target average daily gain has been calculated, click <Okay> and the required 

live weight change (i.e., daily gain) and days pregnant will appear on the Dairy page. Now diet 

formulation can be done, just as with dairy cows. 
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Figure 10. Heifer target growth rate calculator 

 

 

Concluding remarks 

This Concise User Guide will get users in the tropics started quickly with the main functions of Rumen8 

and supports remote coaching. However, going through a classroom course and field practicing the 

use of Rumen8 certainly helps to make more confident and efficient use of the tool. Building up skills 

in dairy cow nutrition and in Rumen8 is further enhanced by referring to the comprehensive 243-page 

Rumen8 User Guide 2022.09 and the 46-page Rumen8 Training Manual 2019.11. The latest edition of 

both documents can be accessed through the Start menu of your laptop. Keep in mind that those 

manuals were written for Australian farming conditions and the examples show more stringent 

recommended levels of nutrients than what is feasible or recommended in the tropics. In all instances, 

use common sense. After all, a software package only is an aid in decision making. The cow has the 

final say. 
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The Building Rural Income through Inclusive Dairy Business Growth (BRIDGE) Project 

Netherlands Development Organisation 
Africa Avenue, opposite Millennium Hall, P.O. Box 40675, Addis Ababa - Ethiopia 

www.snv.org/country/ethiopia 

 

The Inclusive Dairy Enterprise (TIDE) Project - Phase 2 

Netherlands Development Organisation 

Plot 10 Haji Kasaka Road, Kiyanja Ruharo – Kamukuzi – Mbarara 

www.snv.org/country/uganda 

                    Funded by the Embassies of the Kingdom of the Netherlands 

                Addis Ababa, Ethiopia/Kampala, Uganda                                                         

http://www.snv.org/country/ethiopia
https://emea01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.snv.org%2Fcountry%2Fuganda&data=02%7C01%7Crvanklinken%40snv.org%7C7f533e76c65646fe383f08d5fdd4cf62%7C44b97030a737446183c04f575c209c43%7C0%7C0%7C636694012829594132&sdata=wf0FigM9rIlOXLatYccHxu7rrBE41fRJj4anS33zykU%3D&reserved=0
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